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¥ Introduction

V¥ Starting Point

Loading Student:-VectorCalculus

Command

Result

Vector([u, v])

(u)ex-l- (v)ey

Vector([x, y], polar)

(x)e,+ (1)e,

MapToBasis( Vector([x, y]), polar[r, 6])

(\/ x2 +y2 )er+ (arctan(y, x) )ee

VectorField([x, y])

(x)e, + (e,

VectorField([x, y], polar)

(x)e + (e,

simplify( MapToBasis( VectorField( [ x,
»1), polar[r, 8]) )

(r)ér

MapToBasiS( VectorField([u, v]), polar[r, 9])
(ucos(0) +vsin(0) )ér—i- (-usin(0) +vcos(0) )ée

Y One Sure Thing

x rcos(0) cos(9) -rsin(0) . -sin(0)
R=|" |= R = = |R = = ¢
y rsin(0) sin(0) 0 rcos(0) 0 cos(0)
e
.
icos(0) = - i =cos(0) e,
+j Cn(o) 2
sin(6) sin(8) ¢,
-isin(0) = j =sin(0) ér
+i +cos(0)
cos(0) é\ec




uitvj =y (cos(e) ér—sin(e) é\e) -I—v(cos(e) ér

—sin(0) ee)

= (u cos(0) +vsin(0)) ér+ (vcos(0)

—usin(0)) ey

V Identification of Point and Position Vector

* In Cartesian coordinates, the point (a, b) is identified with the vector
ai+bj.

* The Cartesian identification of point with position vector is carried
over to nonCartesian coordinates.

* A point in nonCartesian coordinates is represented by a fictitious
"position vector" in such coordinates.

* At top-level in Maple, points are generally lists: [a, b], but these
don't carry a coordinate system.

* Points in the VectorCalculus packages, being represented as vectors,
carry a coordinate system.

V¥ Implications
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Y Coordinates




The Student VectorCalculus package recognizes the five coordinate systems listed in Table 1.

System Default Names of Coordinate Variables

cartesian X,y

cartesian X, ¥,z

polar 7,0

cylindrical "0,z

spherical r 0,0

Table 1 Coordinate systems recognized by the Student
VectorCalculus package

Talking Points

* Default names for coordinate
variables

* Conventions for spherical
coordinates

* Ambient coordinate system

* "Forgiving" nature of the Student
package

Table 2 lists the two commands relevant to changing the ambient coordinate system.

Command Usage
SetCoordinates SetCoordinates(polar) or SetCoordinates(polar]r,t]
)
GetCoordinates | GetCoordinates() or GetCoordinates(object)

Table 2 Manipulating coordinate systems

Y Vector Objects

V¥ Table of Basic Vector Objects

Table 3 lists the four basic vector objects in the Student VectorCalculus package. These are the
free Vector, the RootedVector, the PositionVector, and the VectorField.

Object Usage

<a, b>

Vector([a, b])

Free vector |Vector(<a, b>)
Vector(<a, b>, polar)
Vector(<a, b>, polarf[r, t])




Rooted

RootedVector(root = [u, v], <a, b>)
vector

PositionVector([a, b])

Position PositionVector([{(s), g(s)], polar][r, t])
vector PositionVector([f(u, v), g(u, v), h(u, v)],
spherical[ p, ¢, 0])

VectorField(<f(x, y), g(x, y)>)
VectorField(<f(r, t), g(r, t)>, polar[r, t])

Table 3 Basic vector objects

Vector field

YV Details for the Basic Objects in Table 3
V' Free vectors

* Tools>Load Package: Student Loading Student:-
Vector Calculus VectorCalculus

Examples of free vectors

(a,b) = (a)e, + (b)e,

z

(a, b, c) = (a)ex—i- (b)ey—i— (c)e

Vector((a, b), polar) = (a)er—l— (b)ee

Vector((a, b, c), cylindrical) = (a)er+ (b)ee + (c)e

z

Vector( (

a, b, c), spherical[p, 0, 9]) =
(a)ep+ (b)

eq)-l— (c)ee

Table 4 Free vectors

V' Rooted Vectors

with(Student.-VectorCalculus) :

PlotVector(RootedVector(root=[1,2], (-2, 1)), scaling
= constrained, view=1[-1..1,0.3])




V' The Position Vector

Loading Student:-VectorCalculus

1_’0Sition Vector( [sz, S3 ], polar) =

s cos(sS)

s2 sin(s3 )

PositionVector([x,y, f(x,y)]) =
X

y
| S(x)
PositionVector([1, ¢, 0], spherical) =
» sin(¢) cos(0)
sin(0) sin(0)
cos(9)

Table 5 Examples of the PositionVector
command

The real benefit of representing curves and surfaces via the PositionVector command is its
compatibility with the PlotPositionVector command by means of which various vector
fields can be superimposed on the curves and surfaces this command draws. (See the




section Visualizations, below.)

\ 4 Vector Fields

with(Student.-VectorCalculus) :

VectorField({(x +y,x —y)) =
(x +y)éx +(x—y)

e
Y
VectorField( (u, v, w)) = (u)éx + (V)Ey + (W)EZ

VectorField( (r + 0, r — 0), polar) =
(r+8)e + (r— G)Ee

VectorField( (u, v, w), cylindrical) =
(u)Er+ (V)Ee + (W)EZ

VectorField( (u, v, w), spherical) =
(u)ér—i- (V)Eq) + (w)ée

Table 6 Vector fields with explicit display of
"moving basis vectors"

* When a VectorField is evaluated at a point, a RootedVector results.

* The evalVEF command is used to evaluate a VectorField at a point.

* If an ordinary evaluation (or substitution) were made, only the components of the vector
would be pointwise evaluated, and the basis vectors would therefore be incorrect, and a
rooted vector would not result.

With the inclusion of the option "output = plot", the VectorField command returns a graph
of the arrows of the field.

¥ Commands Applicable to Basic Vector Objects

Table 7 lists other commands relevant for the use of the basic vector objects in Table 3.

Command Comments

» Changes the display of free vectors and vector fields.
* The default is to display basis vectors, either unbarred or barred.

BasisF t . . . .
LAsIStormat * Executing the command with the argument "false" switches the display
to column-vector format.
* Applied to any of the four basic vector objects, this command returns
About . . :
relevant information for that object.
evalVF « As noted after Table 6, this command is used to evaluate a vector field

at a point, and results in a rooted vector.

MapToBasis . Change coordinates in a free vector or in a vector field.



\ 4

* Does not apply to scalar fields.

ConvertVector

* Converts Cartesian free vector, rooted vector, or position vector to a
free, rooted, or position vector.

Table 7 Commands pertinent to use of the basic vector objects in Table 3

Differentiation

V Basic Differentiation Commands

Table 8 lists the commands in the Student VectorCalculus package that in some way involve

differentiation.
Command Comments
diff * The top-level diff command is modified so that it
_ automatically maps onto components of vectors.
Gradient |° Computes V£, the gradient of the scalar f, returning a vector

field.

Divergence |* Computes V- F, the divergence of the vector field F.

Curl

* Computes Vx F, the curl of the vector field F, returning a
vector field.

Laplacian

« Computes V2f, the Laplacian of the scalar f.

iff

Dircctionall), Computes the directional derivative of the scalar f.

€

TangentLin |, g oy 2 representation of the line tangent to a curve.

ne

Aangentiia i
TangentPla |, potyms a representation of the plane tangent to a surface.

Table 8 Differentiation commands in the Student VectorCalculus package

V Frenet-Serret

Formalism

Commands relevant to the Frenet-Serret formalism are listed in Table 9.

Command Comments
Curvature » Computes K, the curvature of a curve R.
RadiusOfCurv [« Computes 1/x, the reciprocal of the curvature of a curve R.
ature » With "output = plot", returns a graph of R and the circle of curvature.
Torsion » Computes T, the torsion of a curve R.
* Computes R’, a vector tangent to a curve R.
» With the option normalized, returns T, the unit tangent vector.
TangentVector |* With "output = plot", returns a graph of R and representative (unit)




tangent vectors.
* With "output = animation", returns a graph of R and a representative T
traversing R.

al

* For a curve R, computes a vector along N, the principal normal vector.
» With the option normalized, returns N, the unit principal normal.

PrincipalNorm |+ With "output = plot", returns a graph of R and representative (unit)

principal-normal vectors.
» With "output = animation", returns a graph of R and a representative N
traversing R.

Binormal

* For a curve R, computes a vector along B, the binormal vector.

» With the option normalized, returns B, the unit binormal.

* With "output = plot", returns a graph of R and representative (unit)
binormal vectors.

» With "output = animation", returns a graph of R and a representative B
traversing R.

* Returns a sequence of T, N, and B, the (unit) tangent, principal normal,
and binormal vectors for a curve R.

TNBFrame » With "output = plot", returns a graph of R and representative triples of

T, N and B vectors.
* With "output = animation", returns a graph of R and a representative
triple of T, N and B vectors traversing R.

Table 9 Commands relevant to the Frenet-Serret formalism

The Space Curve

tutor implements the graphical aspects of the commands in Table 9. The

computational aspects are captured in the Context Panel when the Student VectorCalculus
package is installed.

V¥ Integration

Table 10 lists the commands in the Student VectorCalculus package that in some way involve

integration.
Command Comments
* The top-level int command is modified to recognize the following pre-defined
int domains: Circle, Ellipse, Parallelepiped, Rectangle, Region, Sector, Sphere,
Tetrahedron, and Triangle.
» Computes J fds, the line integral of the scalar f , taken with respect to arc length s
C
Pathlnt along the curve C.

* The following pre-defined paths of integration of recognized: Arc, Circle, Ellipse,
Line, LineSegments, and Path.
» Access through the Context Panel.

» Computes along the curve C, J F-dr = J F - T ds, the line integral of the
C C
tangential component of the vector field F, where T is the unit tangent vector along




Linelnt

C, and ds is the element of arc length along C.

* The following pre-defined paths of integration are recognized: Arc, Circle,
Circle3D, Ellipse, Line, LineSegments, and Path.

* A graph of the vector field and the integration path is a possible return for the
following pre-defined paths of integration: Circle, Line, LineSegments, and Path.

* Access through the Context Panel.

Surfacelnt

» Computes JJ fdo, the surface integral of the scalar f taken over the surface S, with
S
dc being the element of surface area for S.
* The following pre-defined surfaces are recognized: Box, Sphere, and Surface.
* Surfaces specified by the Surface option can be defined over the following planar
regions: Circle, Ellipse, Rectangle, Region, Sector, and Triangle.

=
=
e

* In the plane, computes J F « N ds, the flux of the vector field F through the plane
C
curve C, where N is a unit normal field along C, and ds is the element of arc length
along C.

* The following pre-defined curves are recognized: Arc, Circle, Ellipse, Line,
LineSegments, and Path. A graph of the vector field and the curve is a possible
return for the Circle, Line, LineSegments, and Path options. One or more
representative normal vectors are drawn.

* In space, computes JJ F « N do, the flux of the vector field F through the surface S,
S
where N is a unit normal field on S, and do is the element of surface area for S.

* The following pre-defined surfaces are recognized: Box, Sphere, and Surface.

* Surfaces specified by the Surface option can be defined over the following planar
regions: Circle, Ellipse, Rectangle, Region, Sector, and Triangle.

* For the Box, Sphere, and Surface options, a graph of the vector field and surface of
integration is a possible return. One or more representative normal vectors are
drawn. However, no graphs are drawn for surfaces specified over any of the pre-
defined planar regions.

* Implemented in a set of Task Templates.

ScalarPote
ntial

Given a vector field F, returns (if it exists) the scalar  whose gradient Vf equals F.

ntial

VectorPote

Given a vector field F, returns (if it exists) a vector A whose curl Vx A equals F.

Table 10 Student VectorCalculus commands that involve integration

VY Visualization

Table 11 lists the commands in the Student VectorCalculus package that do, or can, return graphs.

Command Comment

PlotVector * Graphs one or more free or rooted vectors.

PlotPositionVe

* Graphs the curve or surface represented by a PositionVector, and has

ctor

options for adding vectors from various vector fields defined along the
curve or surface.




* Creates a vector-field object, or graphs its arrows.

VectorField | This graphical functionality can also be accessed through the

Vector Field tutor.

FlowLine » Graph arrows of a vector field, and one or more of its flow lines.

* Provides a unified interface for graphing planar and spatial curves.
SpaceCurve |+ The | Space Curve | tutor provides interactive access to this

functionality.

Linelnt * Forms and evaluates line integrals of the tangential component of a
vector field, and can also return a graph.

* Forms and evaluates flux integrals, and can also return a graph of the

Fl
ux vector field and the curve or surface.

RadiusOfCurv
ature

TangentVector

* These commands for implementing the Frenet-Serret formalism, can
PrincipalNorm| return graphs and animations.

al
Binormal
TNBFrame

Table 11 Student VectorCalculus commands that do, or can, return graphs

¥ Example

Calculate the flux of F = (x + yz) i+ (x2 = y) j +x y z k through that part of the surface

z=10 — x2 — y2 that sits over the disk whose center is at (1, 2) and whose radius is 1.

V¥ Solution via Task Template

Tools>Tasks>Browse:
Calculus - Vector>Integration>Flux >3-D>Through a Surface Defined over a Disk

Flux through a Surface Defined over a Disk

For the Vector Field:

Clear All and Re...




Select Coordinate... =

Flux I...

Simplify

Value
Simplify

Float

V¥ Solution via Explicit Commands
VY Initialize

;> restart
| > with(Student.-VectorCalculus) :
| > BasisFormat( false) :

| > F:= VectorField( [x -I—y2, x2 -, xyz])

Y Obtain the Flux

|:> Flux(F, Surface( <x, v, 10 —x2 —y2>, [x,y]= Circle( (1,2), 1, [r, 9]) ), output
=integral)



|:> Flux(F, Surface( <x, », 10 — ¥ —y2>, [x, 1= Circle( (1,2), 1, [r,0]) ))

Y From First Principles

> Z:=10—x —y2

> X:=1+rcos(0);
Y:=2+rsin(0)

o= [ (L) 4 (27
> do= 1+ (5:7) +(5,7)

|:> N = Normalize(Gradient(z — Z))

2

|:> q = simplify(eval(F «*N-do,z=2))

[> 0:=ewllg, [x=X,y=Y])

[> JIJZTCQ-rder

0°0




